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Preface

Profile

Prerequisites

• There are no prerequisites for this course.

How This Course Is Organized

11i Financial Analyzer New Features is an instructor-led course featuring lecture
and hands-on exercises.  Online demonstrations and written practice sessions
reinforce the concepts and skills introduced.
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Related Publications

Oracle Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Financial Analyzer New Features Table of Contents
vii

(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.



Copyright © Oracle Corporation, 2000. All rights reserved.

11i Financial Analyzer New Features Table of Contents
viii

3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Objectives

After completing this lesson, you should be able to
do the following:
• Recognize general installation enhancements
• Recognize Oracle Financial Analyzer (OFA) Web

client enhancements
• Recognize OFA Windows client enhancements
• Recognize OFA General Ledger (GL)

enhancements
• Identify the functionality available to users on the

Windows and Web Clients
• Compare and contrast Web and non-Web

documents
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Agenda

• Overview of the general installation enhancements
• Overview of the OFA Web client enhancements
• Overview of the OFA Windows client

enhancements
• Overview  of the OFA GL enhancement
• Identify the functionality available to users on the

Windows and Web Clients
• Compare and contrast Web and non-Web

documents
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General Installation Enhancements

• Improved solve performance
– Takes advantage of the new Express

AGGREGATE command
– Improves performance of solves performing

aggregations
– Most improvement seen on sparse data
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Agenda

• Overview of the general installation enhancements
• Overview of the OFA Web client enhancements
• Overview of the OFA Windows client

enhancements
• Overview  of the OFA GL enhancement
• Identify the functionality available to users on the

Windows and Web Clients
• Compare and contrast Web and non-Web

documents
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OFA Web client enhancements

• Enhanced navigation list
• Create, save, and submit documents
• Number formatting
• Format documents
• Color coding and stoplight reports
• Improved Java graph printing
• Java Web data entry forms
• Open document Web application programming

interface (API)
• Single sign-on
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        Logging Into the OFA Web Interface

1. Enter the URL for Financial Analyzer’s ofastart
virtual directory such as    
http://hostname.domain/ofastart/.

2. The Financial Analyzer login page appears. Click
Start. A dialog box asks for your user name         
and password.

3. Type the user name and password provided by
your administrator and click OK.

4. A second page prompts you to select the user
name you want to log into from the drop-down list.
After you have made the selection, click Continue.

5.  A Web page displays the Financial Analyzer
documents that have been distributed to you.

Logging In to the Oracle Financial Analyzer Web Interface
Notes

• To log in to the Financial Analyzer Web interface, you need to be a valid
user. The administrator must establish you as a user and distribute reports
and graphs to you before you can view the interface.

• For information about configuring Financial Analyzer for Web access
after you have installed the required components, see the “Configuring
Financial Analyzer for Web Access” section in the Oracle Financial
Analyzer Installation and Upgrade Guide Release 11i.

• Users who will access Financial Analyzer through the Web must have one
of the following browsers installed on their PC:

– Netscape version 4.61, 4.72, or 4.73.  For version 4.61, SmartUpdate
must be turned on.

– Microsoft Internet Explorer version 4.01 or 5.0, with Java Virtual
Machine (JVM) 5.x.
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OFA Web Report

Navigation listNavigation list

Application workspaceApplication workspace

Application bannerApplication banner

Navigation toolbarNavigation toolbar

Financial Analyzer Web Interface Page Elements
Application Banner
The Application banner area displays the Oracle Financial Analyzer name. It
also contains the Exit and Help buttons.
Navigation Toolbar
The Navigation toolbar provides a set of buttons that enables you to perform
document and data management tasks.
Navigation List
The Navigation list provides access to reports, graphs, data entry forms, and
folders.
Application Workspace
The Application workspace Provides a working area for your reports, graphs,
and data entry forms.
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Using the Navigation List

• Open a report, graph, data entry form, or folder
• Find a report, graph, data entry form, or folder
• View the properties of a report, graph, data entry

form, or folder
• View data submission tasks that are waiting to be

processed by the task processor
• Refresh your view of the shared database
• Expand and collapse the navigation list to view or

hide items
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Additional Navigation List Functions
Available to Analyst Users

• Create and save reports, graphs, and folders
• Move personal reports and graphs into a personal

folder
• Move personal reports and graphs from one

personal folder into another personal folder
• Delete personal reports, graphs, and folders
• Rename personal reports, graphs, and folders



Copyright © Oracle Corporation, 2001. All rights reserved.

11i Financial Analyzer New Features
Chapter 1 - Page 12

Using the Navigation Toolbar
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Using the Navigation Toolbar

• Create a new report, graph, or folder
• Find a report, graph, or data entry form
• Delete personal documents and folders
• Refresh your view of the shared database
• View data submission tasks that are waiting to be

processed by the Task Processor
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Right-Mouse Clicking on Navigation List
Objects to Access the Pop-Up Menus

• Documents folder: New Report, New Graph, New
Folder, Find Document, and Paste.

• Public document folder: Find Documents and
Properties.

• Personal folder: Rename, Delete, Paste, Find
Document, and Properties.

• Public document: Open and Properties.
• Personal document: Open, Rename, Delete, Cut,

Copy, Paste, Submit Documents, and Properties.
• Shared document: Open and Properties.
• Data entry form: Open and Properties.

Navigation List Pop-Up Menus
Right-clicking on a navigation list object activates a menu for that object. The
commands that you can execute from the menu depend on the type of object and
your user privileges.
Notes

• When right-mouse clicking on the Documents folder, only analyst users
see the New and Paste commands.

• When right-mouse clicking on the Personal folder, only analyst users see
the Rename, Paste, Find Documents, and Properties.

• When right-mouse clicking on the Personal document (report or graph),
only analyst users see the Rename, Delete, Cut, Copy, and Properties.
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Number Formatting

• Choose the number of decimal places and scale
numbers

• Specify formats for positive and negative numbers
• Include currency or percent symbols
• Choose whether to display decimal separators,

thousands separators, and leading zeros
• Specify a precedence order to govern how

possible formatting conflicts will be resolved

Number Formatting
As part of formatting a report, you can specify formatting characteristics that
control the way in  which numbers are represented.

Notes
• Whether formatting specifications persist beyond your current working

session in a report depends on the type of user that you are set up to be. If
you are set up as an analyst Web user, you can save reports that you
format, and the formatting settings that you applied will be available the
next time you open the report. If you are any other type of user, you can
apply formatting characteristics to a given report while it is open on your
screen, but you cannot save the report, and any formatting specifications
that you applied will not be preserved when you close the report.

• When you click a column or a row and then apply the number formatting,
the formatting is applied to that column or row on that page only. Clicking
on the data body highlighter and then applying the number formatting
resets the previous number formats on a column or row.
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Formatting Documents
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Formatting Documents

Use the Format Document dialog box to apply
formatting characteristics to the following
components of a report:
• Data
• Row header
• Column header
• Page

Format Document Dialog Box
You can use the Format Document dialog box to control the following:
• Data area: Controls font type, size, color, and background color.

Alignment, control whether to Show All Rows, Hide Zero Rows, Hide NA
Rows, and Hide Zero and NA Rows. It also controls whether to hide or
show the horizontal and vertical grids.

• Row Header: Controls the font type, size, color, background color,
alignment, and row label width.

• Column Header: Controls font type, size, color, background color,
alignment, and column label width.

• Page: Controls font type, size, color, background color, and alignment.
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Applying Color Coding Rules
to Web Reports

• You can compare an FDI with a numeric value.
• You can compare an FDI with another FDI.
• Your color coding specifications are saved with

the report if you are an analyst Web user.
• You can specify the following options when you

define a color coding rule for an FDI: font name,
size, color, style, and background color.

• You can define one or two conditions for each
rule.

• You can associate each FDI in a report with a
maximum of four rules.

Defining Color Coding
You can define color coding rules that specify color formats that will apply
when the data values for a financial data item meet specified criteria. If you are
an analyst user, your color coding specifications are saved with your report and
displayed in the Web version.
You can use color coding to implement conditional format rules such as the
following:

• When values for a financial data item meet a specified value condition, the
data will be displayed in a specified format. For example, you might
define a rule that applies a green background to cells in which the value
for Budget is greater than or equal to a specified amount.

• When values of a financial data item relate to the values of another
financial data item in a specified way, the data will be displayed in a
specified format. For example, you might define a rule that applies a red
background to cells in which the value for Budget is 10% greater than
Budget a Year Ago.

You can also combine two conditions within a single rule and specify whether
the data must meet one or both conditions. For example, you might define a rule
that applies a green background to cells in which the value for Budget is greater
than or equal to a specified number and Budget is 10% greater than Budget a
Year Ago.
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Using the Color Coding Wizard

1. Color Coding Wizard—Step 1 of 4: Specify FDI.
2. Color Coding Wizard—Step 2 of 4: Specify Data

Conditions.
3. Color Coding Wizard—Step 3 of 4: Specify

Appearance.
4. Color Coding Wizard—Step 4 of 4: Specify Name.
5. Color Coding Dialog Box.

Color Coding Wizard—Step 1 of 4: Specify FDI
This is the first step in the Color Coding Wizard. First, you select the financial
data item that you want to associate with a rule and specify whether you want to
use the stoplight color coding option.

Color Coding Wizard—Step 2 of 4: Specify Data Conditions
Use this step to specify a data condition that will be used for selecting the data
to which you want to apply color coding and formatting. You can also use this
step to add a second data condition to the rule. Once you select the second data
condition, you can specify one of the following:

• Both conditions must be true (AND operator) in order to apply the color
coding rule.

• Either condition could be true (OR operator) in order to apply the color
coding rule.

This step is available when you create or modify a rule.
Color Coding Wizard—Step 3 of 4: Specify Appearance

Use this step to specify color coding and text formatting characteristics,
depending on whether or not your report uses stoplight formatting, as follows:

• If you have not selected the Use Stoplight Color Coding option for this
report, this step enables you to specify the font, size, style, font color, and
background color for the data that meets the rule requirements.
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• If you have selected the Use Stoplight Color Coding option for this report,
this step enables you to specify a background color for cells containing
data that meet the rule requirements.

Color Coding Wizard—Step 4 of 4: Specify Name
Use this final step in the wizard to specify the name that you want to use for the
rule.

Color Coding Dialog Box
Use this dialog box to apply color coding to data in the current report that meets
certain conditions, which you specify using a wizard associated with the dialog
box. Each set of conditions is associated with a particular financial data item in
the report. Each set of conditions and related formatting information is called a
color coding rule. You can associate a maximum of four rules with each
financial data item in a particular report.
The Appearance column displays different information depending on whether
you have selected the Use Stoplight Color Coding option. For example:

• If you have not selected the Use Stoplight Color Coding option, this
column displays the color that you chose to highlight the background of
cells that meet the condition or conditions specified in each rule, as well as
any formatting characteristics that you have applied to data that appears in
those cells.

• If you have selected the Use Stoplight Color Coding option, this column
displays only the color that you chose for highlighting the background of
cells that meet the condition or conditions specified in each rule. The data
is visible only when you click a cell.
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Color Coding Report

Notes
• Whether formatting specifications persist beyond your current working

session in a report depends on the type of user that you are set up to be. If
you are set up as an analyst Web user, you can save reports that you
format, and the formatting settings that you applied will be available the
next time you open the report. If you are a non-analyst Web user, you can
apply formatting characteristics to a given report while it is open on your
screen, but you cannot save the report, and any formatting specifications
that you applied will not be preserved when you close the report.

• Stoplight formatting affects the entire report, rather than affecting a single
financial data item, as do the other formatting conditions that you define
as part of a particular rule. Stoplight formatting is either on or off for the
entire report.

• You can define a maximum of four rules for each financial data item.
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Stoplight Color Coding Report

Stoplight Color Coding Report
Report cells that meet the data conditions specified in the rules defined for this
report appear as solid blocks of color. The data in the cells is not visible;
however, you can click a cell to display its value as shown in the slide example.

Note
• You specify the color for these cells using the Color Coding Wizard.
• The data values in  the colored cells appear only when you click a cell.
• Stoplight formatting affects the entire report, rather than a single financial

data item, as do other formatting conditions that you define as part of a
particular rule. Stoplight formatting is either on or off for the entire report.

• If you do not select the Use Stoplight Formatting option, the data values
appear in the cells that meet the data conditions that you specified in the
rules along with the color coding. The text in the cells is formatted using
the font and size that you specified in the Color Coding Wizard.
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Submitting Shareable DocumentsSubmitting Shareable Documents

• Available on the Web Client in OFA 11i.
• The administrator authorizes users to submit

documents to the shared database.
• The administrator runs the task processor to

update the shared database with the User_Update
task.

• Authorized users submit documents to the shared
database.

• The administrator runs the task processor to
update the shared database with the Submit task.

Sharing Documents
As an administrator, you can grant budget and analyst workstation users the
ability to create and modify sharable documents and to submit them to the
shared database so that they will be available to other users. You can also
remove this ability at any time after you have granted it, as follows:

• You can completely remove a user’s ability to author and submit any
documents. To do this, you must modify the user maintenance settings for
that user.

• You can prevent a user from modifying a particular document while
leaving intact the ability to originate and modify other sharable
documents. You accomplish this by distributing the document to the user
with the appropriate distribution action, as follows:

– If you have already distributed this document to the user with the
ability to write modifications back to the shared database, you must
distribute the document to the user again and remove his or her write
access.

– If you are distributing the document for the first time to a user who
otherwise has been granted the ability to modify sharable documents,
you must distribute the document to the user using the Add
distribution action instead of the Add with Write Access.

Notes
• For information on sharing documents, see Chapter 10, “Transferring

Data,” in the Oracle Financial Analyzer User’s Guide, Release 11i. See
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also the “Sharable Documents” help topic in the Oracle Financial
Analyzer 11i online Help system.

• This feature was available to users using the Windows client interface
only in OFA 6.3.
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Submitting Shareable Documents (Continued)
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Submitting Shareable Documents
(Continued)

Submitting Shareable Documents
(Continued)

• The administrator refreshes the personal database
and distributes the document to other users.

• Authorized users with write access can modify
and submit documents to the shared database.

• Other users of the sharable documents can
refresh the documents to see the changes.

• The administrator can remove the shared
document write access from users.

Note
• Only budget and analyst workstation users who have been specifically

designated by their administrators as having the right to create or modify
sharable documents can submit a document to the shared database.

• For a document to be sharable, it must be based on structures that reside in
the shared database. A sharable document cannot contain personal
structures.

• A document that is submitted to the shared database becomes sharable
after the administrator receives it (runs the task processor and refreshes the
personal database) and distributes it to other users.
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Improved Java Graph Printing

• Print only current page of data or all pages of data.
• Specify the graph size:

– Fit to page (maintain proportion)
– Actual size

• Specify left, right, top, and bottom margins
• Include a header
• Include a footer

– Date
– Page number
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Java OFA Web Data Entry Form

OFA Web Data Entry Form
Data entry forms support Web-based data collection. Users who have a Web
browser can use data entry forms to accomplish the following tasks:

• Enter new data into the shared database
• Make changes to existing data in the shared database
• Calculate data based on data that is newly entered. Data entry forms are

designed for controlled data collection. Users can enter data and run
predefined calculations using data entry forms.
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Data Entry Form Toolbar

• Export to Spreadsheet—Exports data from the
current data entry form to a spreadsheet

• Submit Data—Submits data from the current data
entry form to the shared database

• Recalculate—Recalculates the data in a data entry
form based on new data that you have entered or
modified

• Close—Closes the current data entry form
• Print—Prints the current data entry form
• Display Help—Displays Financial Analyzer Web

on-line Help system
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Open Document Web Application
Programming Interface (API)

• This API enables an OFA external Web user to
open a report or graph automatically from a URL
or a Web link.

• The start-up method will only require a parameter-
based URL.

• The URL can then be shared by other users to
access an OFA document.

• Display the document either in an existing OFA
Web window or in a new window.

• Display or hide the Navigation list and the
application toolbar.

• Specify a custom URL to invoke when the user
exits the OFA Web session.

Notes
• The URL can be shared by other users to access an OFA document only if

they have access to that document and if they are valid OFA users.
• For additional information about Open Document Web API, see the “New

Hooks in the Oracle Financial Analyzer 11i Web Interface” technical note.
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Open Document Web API
(Continued)

http://[server.domain]/oowa.exe/ExpSrv632/

dbASWEBINT/APP.START?OFA/[database]/DOCOPENENT

RY/[document]/[PARAM1]/[PARAM2]/[PARAM3]/...

URL Format:URL Format:

http://lserhal-lap.us.oracle.com:8080/oowa-

bin/oowa.exe/ExpSrv632/dbASWEBINT/APP.START?

OFA/C:%2foui_home1%2fofa11i/DOCOPENENTRY/

DI.AA47147/NEWWINDOW/HIDEBOTH/www.yahoo.com

URL Sample:URL Sample:
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Example: Open Document Web API
(Continued)
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Single Sign-On

• Integrates OFA with other Oracle Applications
• Allows users to log on to their host machine:

– Authenticated once
– Have access to all Oracle Applications

available to them
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Agenda

• Overview of the general installation enhancements
• Overview of the OFA Web client enhancements
• Overview of the OFA Windows client

enhancements
• Overview  of the OFA GL enhancement
• Identify the functionality available to users on the

Windows and Web Clients
• Compare and contrast Web and non-Web

documents
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OFA Windows Client Enhancements

• Improved Export to File
• Row filtering by attribute in worksheets
• Refresh data capability for analyst users
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Exporting Report and Worksheet Data

• Export data using the following formats:
– Text (*.txt)
– CSV (Comma delimited) (*.csv)
– Microsoft Excel '95 (*.xls)
– Microsoft Excel '97 (*.xls)
– Microsoft Excel 2000 (*.xls)

• Export document pages to either multiple
worksheets with an optional Table of Contents
page or to a single worksheet.

• Select whether to include or exclude the
formatting information with the data export.

Export to File Dialog Box
This dialog box enables you to export report and worksheet data to files that can
be used by other applications. You can also use this dialog box to export graph
data to a Windows bitmap (*.bmp) file.
The format choices for which you need to export your document include the
following:

• BMP—Exports the data in Windows bitmap (*.bmp) format. This format
is available only when the active document from which you are exporting
data is a Financial Analyzer graph.

• Text (*.txt) —Exports the data in text file format, in which labels and
data values are separated by fixed-width tabs.

• CSV (Comma delimited) (*.csv) —Exports the data in Comma
Separated Values format, in which labels and data values are separated by
commas.

• Microsoft Excel '95 (*.xls) —Exports the data in Microsoft Excel 95
format.

• Microsoft Excel '97 (*.xls) —Exports the data in Microsoft Excel 97
format.

• Microsoft Excel 2000 (*.xls) —Exports the data in Microsoft Excel
2000 format.
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Row Filtering by Attribute in Worksheets

• The dimension values displayed in the row (down)
position can be filtered based on a user-selected
attribute relationship with a grouping dimension in
the page position of the Worksheet.

• This is not available on web data entry forms.

Row Filtering by Attribute
This feature enables you to specify an attribute to apply to the worksheet.
Choose the attribute that you want to apply from the drop-down list. The list
displays all attributes for which the following is true:

• The base dimension for the attribute is in the down position in the
worksheet.

• The grouping dimension for the attribute is in the page position in the
worksheet.

Note
• If drilling has occurred in the dimension in the down position in the

worksheet, you cannot specify an attribute.
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Row Filtering by Attribute in Worksheets

As you page through the organization types, only organizationsAs you page through the organization types, only organizations
rows that belong to that organization type are displayed.rows that belong to that organization type are displayed.
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Refresh Data Capability for Analyst Users

• Analyst users can refresh their view of the shared
database to view any updates to the data.

• A new Refresh Data menu item is added to the
Manage menu for analyst users.
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Agenda

• Overview of the general installation enhancements
• Overview of the OFA Web client enhancements
• Overview of the OFA Windows client

enhancements
• Overview  of the OFA GL enhancement
• Identify the functionality available to users on the

Windows and Web Clients
• Compare and contrast Web and non-Web

documents
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OFA GL Enhancement

• The Super Administrator user can specify an
option to populate an attribute automatically
between two GL dimensions during the balance
load from GL.

• This attribute can be used for the new Row
Filtering feature by the Attribute feature in
worksheets.
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Agenda

• Overview of the general installation enhancements
• Overview of the OFA Web client enhancements
• Overview of the OFA Windows client

enhancements
• Overview  of the OFA GL enhancement
• Identify the functionality available to users on the

Windows and Web Clients
• Compare and contrast Web and non-Web

documents
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Functionality of Analyst User

Feature

Views shared database through
personal database filter

Attaches personal and shared
database

Creates/shares personal
documents

Personal database holds
personal/distributed documents

Writes data back to shared
database

Web Client

Yes

Yes

Yes

Yes

Yes (data entry
form)

Windows Client

Yes

Yes

Yes

Yes

Yes (worksheet)
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Functionality of Budget User

Feature

Views personal database only

Views shared database only

Attaches shared database

Attaches personal database

Holds local copy of data

Creates/views personal
structures and documents

Shares personal documents

Web Client

No

Yes

Yes

No

No

No

No

Windows Client

Yes

No

No

Yes

Yes

Yes

Yes
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Functionality of Budget User
(Continued)

Feature

Personal database contains
personal/distributed structures

Personal database holds a local
slice of the data from the shared
database

Writes data back to shared
database

Views shared documents and
structures distributed to it

Views shared database through
a filter based on distributed
structures

Web Client

NA

NA

Yes (data entry
form)

Yes

Yes

Windows Client

Yes

Yes

Yes (Submit Data)

Yes

No
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Functionality of Administrator User

Feature

Views personal database only

Views shared database only

Attaches shared database

Attaches personal database

Holds local copy of data

Creates/views personal
structures, documents, and
local data

Shares personal documents

Web Client

No

Yes

Yes

No

No

No

No

Windows Client

Yes

No

No

Yes

Yes

Yes

Yes

Administrative Tasks Available Only Using the Windows Client
• Solve/group solve definitions
• Copy data
• Custom menus
• Define dimensions/dimension values
• Define FDIs
• Define attributes
• Define hierarchies
• Define models
• Define data loaders
• Distribute structure and data
• Maintain users
• Manage the Task Processor
• Manage write access
• Submit and refresh data
• GL link administration
• GL drilldown using ADI from a report
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Functionality of Administrator User
Feature

Personal database contains
personal structures

Personal database holds a
local copy of the data from
the shared database

Writes data back to shared
database

Performs user maintenance

Performs structure/data
distribution

Create write access profiles

Controls Task Processor

Web Client

NA

NA

Yes (data entry
form)

No

No

No

No

Windows Client

Yes

Yes

Yes (Submit Data)

Yes

Yes

Yes

Yes
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Agenda

• Overview of the general installation enhancements
• Overview of the OFA Web client enhancements
• Overview of the OFA Windows client

enhancements
• Overview  of the OFA GL enhancement
• Identify the functionality available to users on the

Windows and Web Clients
• Compare and contrast Web and non-Web

documents



Copyright © Oracle Corporation, 2001. All rights reserved.

11i Financial Analyzer New Features
Chapter 1 - Page 46

Comparing Web Reports  and Non-Web Reports

Copyright   Oracle Corporation,  2001.  All rights reserved.
®

Comparing Web Reports
and Non-Web Reports

Non-Web Reports

Yes

No

Yes

No

Yes (.xls, .csv, .txt)

Yes

No

Yes

Yes

Characteristics

Client installation to view

Change document type

Change fonts, color ...

Define color coding

Export data

Drill in reports

Drill across in reports

Select values

Save reports

Web Reports

No

Yes

Yes

Yes

Yes (.csv, .txt)

Yes

Yes

Yes

Yes (analyst)
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Comparing Web
and Non-Web Graphs

Non-Web Graphs

Yes

No

Yes

No

No

Yes

Yes

Yes

Characteristics

Client installation to view

Change document type

Change fonts, color ...

Drill in graphs

View numerical values

Export data

Select values

Save graphs

Web Graphs

No

Yes

No

Yes

Yes

Yes

Yes

Yes (analyst)
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Comparing Web Client Data Entry Form
with Windows Client Worksheet

Feature

Access via Web

Access via  Windows client

Cell locking

Enter and submit data

Grow, increase, and spread
data

Recalculate data

Save and reset data

Select data

Worksheet

No

Yes

No

Yes

Yes

Yes

Yes

Yes

Data Entry Form

Yes

No

Yes

Yes

No

Yes, if form includes
solve definition

No

No

Note
The “save and reset data” task on the slide refers to being able to save and reset
the data in the personal database associated with the user and not in the shared
database.
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Comparing Web Client Data Entry Form  with Windows
Client Worksheet

Copyright   Oracle Corporation,  2001.  All rights reserved.
®

Comparing Web Client Data Entry Form
with Windows Client Worksheet

Feature

Drill data

Include multiple FDIs

Print data

Change tiles layout

Insert row/column

Format data

Export data

Asymmetric format

Combined input of text
and numeric data

Worksheet

Yes

No

Yes

Yes

Yes

Yes

Yes

No

No

Data Entry Form

Yes

Yes

Yes

No

No

No (yes when authoring)

Yes

Yes

Yes

Note
The “save and reset data” task on the slide refers to being able to save and reset
the data in the personal database associated with the user and not in the shared
database.
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For More Information

• Attend the “11i Financial Analyzer: Introduction”
2-day instructor led training course
(available February 19, 2001)

• Attend the “11i Financial Analyzer:
Administration” 3-day instructor led training
course (available February 19, 2001)

• Log in to OLAPWeb (internal site only)
http://olapweb.us.oracle.com/

• Log in to Metalink
http://metalink.oracle.com
(N) Technical Libraries > Business Intelligence and
Warehousing Tools > Oracle Financial Analyzer (OFA) >
Additional Information > Oracle Financial Analyzer 11i
New Features Instructor Led Training
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Summary

In this lesson, you should have learned how to:
• Recognize general installation enhancements
• Recognize OFA Web client enhancements
• Recognize OFA windows client enhancements
• Recognize OFA General Ledger (GL)

enhancements
• Identify the functionality available to users on the

Windows and Web Clients
• Compare and contrast Web and non-Web

documents
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